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= IMS Explorer Overview
= DBD and PSB Graphical View
= IMS Explorer connecting to ODBM

= IMS Explorer using the IMS Catalog
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IMS Application Development Challenges

Shrinking knowledge base around IMS &
hierarchical data base model

Difficult to find DLI programmers

Fewer experienced COBOL and PL/l programmers

Lack of integrated development solutions and tools

Difficult to test and deploy applications

© 2012 IBM Corporation



= Easier visualization and editing of IMS Database and Program (PSB) Definitions

— Provide graphical editors to:
 Display IMS database hierarchical structures
 Display/create/edit PSBs
« Change/add fields on a DBD

— Import COBOL copybooks and PL/I data structures to a database segment*
— Generate DBD and PSB source
— Generate metadata needed by Java applications and for SQL access from Explorer

= Ability to easily access IMS data using SQL statements
— Leveraging IMS 11 Universal JDBC driver and Open Database

= Connectivity to the z/OS system
— Browse a Data Set and submit JCL
— Import and export DBD and PSB source files from a Data Set to the IMS Explorer, and
vice-versa

*Requires RDz 8.0 or later
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EDIT

IMS.V11.DBDC.SDFSISRC (DFSAUTDB) - 01.00

Command ===>

Q08500
Q0860
Q08700
008800
008900
oJokelejeo
Q09100
Q9200
009300
009400
009500
oJokelsielo
o]olergolo
QL9800
009800

FIELD NAME=SALDATE,BYTES=8, START=33, TYPE=C
FIELD-MHEME=LASTNME, BYTES=25, START=411
E NAME=SALESPER,
PARENT= ( (DEALER, ],
BYTES=6,
POINTER= (LPARNT, LTWINBWD, TWINBWD)] ,
RULES= (VVV)
NAME= (EMPNO, SEQ, U) ,BYTES=6, START= i
- e R, BYTES=15

NAME= OU%TH BYTES 5,5TART=1, TYPE=C
NAME=SALESYTD, BYTES=5, START=6, TYPE=C
NAME=COMSSION, BYTES=5, START=11, TYPE=C

DBDGEN

FINISH

END

HEKKEE KK EXKEEKEEX KK R EEx Rk kXX Bottom of Data *xExxxxxx

Columns 00001

opOT2
SR

Logical relationship

in DBD source

(EMPL, PHYSICAL, EMPDB2) ),

Understanding a
database by
reading its source
isn’t easy for
newcomers to IMS
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Displaying an IMS Database Structure with IMS Explorer

LD Project Explorer 23 = B || ¢" weos2.dbd i &
% = Project: SA Visit || Database name: ALTODE Database access type: (HDAM, D5AM)

=] @ IM5 Explorer Demao
[#-T=F IMS Explorer SQL Script DFST

© B mepioeres B R ATROR

=-fgh sA visit
+ 2 autpsbi — DEALER
+-H} autpsbal (2 Target of a secondary index
#-H autpsbel Length: 61 bytes
[#-B JRE System Library [jdk] =
[ .ﬁ imsjava.jar - C:\Progran s NERNE =
=4 pep |
= autodd | |
[ Source — MODEL — SALESPER
¥ AUTODB.dbd Length: 37 bytes 4 Logical child
+-[3 autoldb v =L MODKEY Length: 6 bytes
I R\lﬁﬂl—-
#-[J empdb 2 =L EMPNO
[+ D empldb2 =
:'+J G sindex 22
-k PSB
— ORDER — SALES — STOCK = SA
20 Target of a secondary index LY Logical chid L% Logical parent Length* 15 bytes
Length: 74 bytes Length: 85 bytes Length: 46 bytes =
. ORDMNBR 1 SALENUM L STKVIN
Much easier z Z 4
to
understand = STOCSALE
Y Virtual logical child
the database siaisdasiiiiisate
structure kg DLRNO
bzt SALENUM
w




i d 51

Project: Imsexplorerproject Database name: AUTCODE Database access type: (HDAM,QSAM)
DBD name: AUTODB DBD name: EMPDB2
= DEALER | | = EMPL
@ Target of a secondary index Shows Logical i Logical parent
Length: 61 bytes relationship Length: 36 bytes .
= Click here to o s Click here to
k= DLRNO s e tween k=t EMPNO show related
E5 DLRHAME &F:;ij:g e databases B LASTHME databases
&3 CITY ——" EG FIRSTNME
== DED a
Bl ZIF Y
DRHONE 7N N |
L=~ 5L | ekl ar
et «F="— EMPSAL —' EMPLINFO
| L ganett 5 LA virtual logical child Length: 61 bytes
= MODEL — SALESPER =1 DLRNO E ADDRESS
Length: 37 bytes 5 Logical child — E5 STREET
= MODKEY =Length: & bytes &5 cITY
e b=l EMPHO B2 STATE
| - Er i
L | :
= ORDER — SALES ", — STOCK — SALESINF
(2 Target of a secondary index %% Logical child ..'h “‘E., Logical parent Length: 13 bytes
Length: 74 bytes Length: 85 bytes [a, [ Length: 46 bytes =
1 ORDMER E2L SALENUM ;?::ETK\.!IN
B LASTHME L — -
B FRSTHME Much easier to
BG{ DATE
=5 TIME understand the
= hierarchy &
related
— STOCSALE
L& wirtual logical child data bases
1 DLRNOD
1 SALENUM
v
@ auTODE
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Displaying an IMS Database Structure with IMS Explorer...

i 4 2

|| Project: IMSExplorerProject

DBD name: AUTODB

&l

' " auTODE |

E properties &2

Property
= 1-Segment (SEGM)
Alias (EXTERMALMAME)

Database name: AUTODE

|| Database access type: ﬂ;IDAM,OSAM]l

— DEALER

(] Target of a secondary index
Length: 61 bytes

L DLRMO
50 DLRNAME
B CITY

= ZIP

56 PHONE

Click Here

— MODEL
Length: 37 bytes

FL MODKEY
B3 MODTYPE
B3 MAKE

Character encoding (ENCODING)
Data Capture exit routines (EXIT)

Length (BYTES)

Farent segment (PARENT)

Pointers (POINTER)
Remarks (REMARKS)

Rules for segment insert, delete, and replace (RULES)
Segment Edit/Compression exit routine ({COMPRTM)

\‘g_l Error Log [3_. Problems | B Consdle | E 0L Results

Value

SALESPER

=]
{(DEALER), (EMPL,PHYSICAL EMPDEZ))
CTWINBWD, L TWINBWD LPARNT)

(VVV,LAST)

|~ SALESPER

k4 Logical child
Length: 6 bytes

e

1 EMPNO %

DBD name: EMPDB2

View:

— EMPL
‘:‘E. Logical parent
Length: 56 bytes

L EMPNOD
B0 LASTNME
&8 FIRSTNME

il

.-".."]

L4 virtual logical child

— EMPLINFO
Length: 61 bytes

EL DLRNO

B2 STATE

il

w

Type of relationship

is shown in

Properties

ek

1

| |
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DBD name: AUTODB

— DEALER

EL DLRNO
53 DLRNAME
&5 CITY

& ZIP

55 PHONE

E, Target of @ secondary index™
Length: 61 bytes

3

# Manage Fields
Visualize As
[+ Expand Al
—| Collapse all
L Reset Layout

=~ MODEL
Length: 37 bytes

el Show Bropert
[=h Print \

5 /51

55 MODTYPE
E-L MODKEY
5l MAKE

5l MODEL
53 YEAR

55 MSRP

5l COUNT

.

Hun As

Debug As

Profile As
Validate

Team
Compare With
Replace With

To Print
the
Layout
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IMS.V11.DBDC.SDFSISRC (DFSAUT11) - 01.00 Columns 00001 OROT2
==> Scroll ===> CSR_
ﬂU?SZPCB PCB TYPE=DB, DBDNAME=AUTOLDB, PROCOPT=GRP, KEYLEN=64, X

PROCSEQ=SINDEX22
SENSEG NAME=DEALER, PARENT=0
SENSEG NAME=MODEL, PARRENT=DEALER
SENSEG NAME=STOCK, PARENT=MODEL

X

AUSIZ2PCB PCB TYPE=DB, DEDNAME=SINDEX22, PROCOPT=GRDP, KEYLEN=28
SENSEG NAME=SINDXB, PARENT=0

EMPLPCB PCB TYPE=DB, DBDNAME=EMPLDB2, PROCOPT=AP, KEYLEN=10
SENSEG NAME=EMPL, PARENT=0
SENSEG NAME=DEALER, PARENT=EMPL
SENSEG NAME=SALESINF, PARENT=DEALER Grez‘p‘;;'een
SENFLD NAME=QUOTA, START=1 Display of
SENFLD NAME=SALESYTD, START=7 PCB Definitions
SENSEG NAME=EMPL INFO, PARENT=EMPL withinialksB
PSBGEN PSBNAME=AUTPSB11, LANG=JAVA

END
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Building a PCB definition with IMS Explorer

=% IMS Dealer Demo
28 IMS Universal Drivers Metadata
= JRE System Library [idk]

Click the i

required PSB

Then

select the require

=
fmg imsudb,jar - C:'\Program Files\IEMIMS Er .
[{ DED : en select “Edit data sensi igh
!i DBD Source o
=57 psB f
@& AUTPSB11.psh
% PSEB Source
= O
@ auToDB.cbd | AUTPSBILpSD 53
|| Project: IMSExplorerPraject || PSB name: AUTPSE11 ||
L 1 [A]
Full-function or Fast Path database PCB statement (TYPE=DB)
The PCB statement describes a PCB for a DL/T or & Fast Path database. Learn more. ..
PCE Mu... | PCBMa... | DBEDMA... | PROC... SEB KEYLEM PQOS PROCS... | VIEW=.., | LIST PSELOPT | ACCESS
1 AUTOL... AUTOLDE | AP Mo 100 Single Mo Yes ’ Add... ]
i ALTS1P... AUTOLDE  GRP Mo 100 Single SINDEX11 Mo Yes
3 ALTSZP,.. AUTOLDE  GRP Mo &4 Single SINDEX22 Mo Yes ’ == ]
4 AIUSI2PCE  SINDEX22  GRODP Mo 28 Single Mo Yes ot
5 . EMPLPCE EMPLDEZ AP Ma 10 Single Ma Yes

b

To Display the PCB

Graphically and
Optionally edit
sensitivity

( | Edit data sensitivity... |
S~ W

|Edit the segment and field sensitivity for the selected PCB,
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Building a PCB definition with IMS Explorer ...

| Project: IMSExplorerProject

I P5Bname: AUTPFSELIL ||

I @ All Segments (Edit Sensitivity)

WEMPL T 1
Length: 56 bytes

W =L EMPNO

[ B LASTNME

[ §8 FIRSTHME

Deselect these two
fields

IV EG SALESYTD

[ @ COMSSI0ON
e —

v DEALER v EMPLINFO
Length: 60 bytes Length: 61 bytes
W L DLRNO W [JSTATE
W L DLRNOD ¥ E§ ADDRESS
¥ E3 DLRMAME ¥ 55 STREET
W EE CITY W B3 Iy
vV & zIF v E§ ZIP
[w @ FHOME I —
v SALESINF
Length: 15 bytes
WV E§ QUOTA

The Senfld shows in the “Generated Source”

@ Test

1= .sgbxeditor_project
13 TVSExplorerProject

—

[ Project Explorer 52 E] 2 =0
5 LIST=YES
= 3‘:5 -, = 5 S [A]
! SENSEG NAME=SINDXE,
@ AUTPSBLLpsb [Al ELDENT=0
@ DFSIVPI7.psb HMEPLECH  PUS LYpE=DH,
& DFssAvD9.psh DEDNARME=EMPLIZZ,
= Eﬁ PSE Source ERCCOET—AF
ROC .
=] EE Generated Source SE=N0
E| AUTPSB11 rEyrEN—co
= sEYILEN=10,
El Ural¥ra PC'3=3 IE_ =
E| brssamos A
-k Imported Sourcz LTsT=vES ’
— ALTREEIL SENSEG NAME=EMPL,
El DFSIP37 [y P,
< w | [>] SENFLD MAME=EMENC,
STLRT=1
U Navigator £ =0 :
REEPL=YES
@ | 5E T SENSEG NAME=DEALER,

FARENT=EMFL
SENSEC NAME=SLLESINF,
PARENT=DELLER
SENFLD NAME=QUUTA,
START=1,
REPI=YLS
SENFLD NAME=SLLESYTD,
START=7,
REPL=YES
BEMEFRR MAME=FMPT.TMFO,
FLRENT=EMFL

—

o= Outline

A1 outline is

|
é
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Building a PCB definition with IMS Explorer ...

|.—[\j Project Explorer &3 = <;==';> :{=:=> = () ED Compare {IMSExplorerProject/PSB Source fGenerated Source/AUTPSB1L - TMSExplorerProject/PSE Source/Imported Source/AUTPSE11)

= 5’ IMSExplorerPraject |=| Text Compare

& IM3 Universal Drivers Metadata - : -
- JRE System Library [idk] IMSExplorerProject/PSE Sourc UTPSE11 | IMSExplarerProject/PSB S
s e ¢ AL
il AL nterprise VEIOpMmEN = !

@ imsudb jar - C: \Proar SENSE
- DED LU= SENSEG T=3
& 4% DBD Source SENSEG NAME=3INDXS, o 2
=-lF psB FRRENT=0 SENSEG NAME=S
& AUTPSB11.psh EMFLECE  FCE TYPE=DE, SENSEG NAME=S INF, PARENT=5 PER
-y DFSIVP37.psh DEDNRME=EMFLDEZ, SENSEG NAME=FMPLINFO, PARENT=SALESPER
. -y DFSSAMDS.psb FROCCPT=RE, AUTS1PCE PCB TYPE=DB, DEDNAME=LUTOLDB, PROCOPT=GRE,
= psB Source 3E=HC, EQ=SINDEX11
-4 Genersted Source FEYLEN=10, SE ORDER, PARENT=0
BN FOS=5INGLE, SEX NAME=MODEL, PARENT=ORDER
ErTOFsTPS RCCESS=DB, SE NAME=DEALER, PARENT=MODEL
Bl procauod  New » LT 3EN NAME=STCCK, PARENT=MODEL
L & 1 SENSEG NAME=EMPL, "
Bimo show In Alt+Shift+ > B R
E] AUTS2ECS B, DEDNAME=AUTOLDE, PROCOPT=GRP,
= Cpen F3 e
=rbraErEs NDEX22
[E oFssamo 3 R, PARENT=0
[ script1.sql B Copy Qualfied Name 3 , ERRENT=DELLER,
[ selectPBosgl = - s =STOCK, PARENT=MODEL
[, selectrhone.sgl | L2 . Cul =
b Test ¥ Delete Delete LUSI2PCE PCB TYPE=DB, DEDNAME=SINDEX22, PROCOFT=GE
Build Path 4 FRRENT=D SENSEG NAME=SINDXB, PARENT=0
. SENFLD NAME=QUOTR,
STRRT=1, EMPLECE PE=DB, DEDNAME—EMPLDB2 , PROCOPT=AF,
< REPL=YES NAME=EMPL, BARENT=0
Exg Import... SENFLD NAME=SATESYID, TilE= TR, PARENT—ENMPL
£ Export... START=7§ NAME ENT=DEALER
P - BEESES ) NAME=QUOTA, START=1
efresl SENSEG NAME=EMPLINFO
o e ot ) NAME=SALESYTD, START=7
Validate e ST NAME=EMPLINFO, PARENT=EMPL
B E R et Dl T B e
Shaw in Remote Systems view 1 FSENRME=RUTFS511, LANG=JRVE
Run As ] 0
Debug As 3 <] A | [l] %] I | [l]
Profile As l SR ﬂT'n, Problems (E Consale (E_P History &2 e = |Eﬁl ]
TESTT 4 '__ I_‘ I |
Compare With // B Each Other
Compare the Resiace it y -
£ 14
Imported” &
“G ” he Senfla i Generated Source”
enerated e Senfid shows e "Generateda Source

source
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L 330 30 5 S KKK S K I K K K KKK K R K I I K K K K T IS S O KK K K K K O S S S KK K K K I S K R K K K K K
WTD Start of the DDLTE stream
U status card has all 1's so all tracing is ON.
U status card has 00002 so we use the second PCB in the P3B
11111 opEe2
WTO Mow deing GN through the database
GN
DATA KAAL11xxK1x*
01 K1l oees5KAAlLl
GHN
DATA KEBB11xxK2
0z K2 O011KAA11KEBBB11
GHN
DATA KAA31KEE31K31311131213131314131513KEE31K5R31
03 K3KS OR21KAATI1KBBB11KAA31KEE3]
GN
DATA KAA31xxK1*
04 K1¥ 0026KAAL11KBBB11KAA31KEE31KAA3L
GN
DATA KAA31KEE32K31321132213231324132513KEE32Kb5R32
2 SCREEN 2 3 QUIT 4 FILE 5 REPEAT 6 ADD
PF 7 BACKWARD 3 FORWARD 9 XFILE 10 LEFT 11 RIGHT 12 JOIN

L
E
E
L
E
E
L
E
E
L
E
E
L
E
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Displaying an IMS Database with IMS Explorer

BN Explorer - Imsexplorerproject/Script1.sql - IMS Enterprise Suite Explorer L:..JLEE]WI
File Edit Mavigate Search Project SQL Run  Window Help
Ci~ [H T Q- i Y i LR T (i3 Database De... »
[ Project Explarer 2 E % ¥ T O| [0 selectSeript1.sql ft}" DI21PART.dbd I(I'_=I PARTROCT !/E STOKSTAT (@ *saiptlsal B = ()| e b
|El DFsIvPA [~ s T PCEO1.STOX .PARTROOT_PARTXEY, PCEOL.S5TOE UNPLREQMTS, ~ (3 seLecT st
|5l DFssamMD2 PCBO1.STOKSTAT.UNIT, PCBO1.STOKSTAT.DEPT, PCBO1.STOKSTAT.UNITPRICE,
|5l DFssAMD3 PCBO1.STOKSTAT .CURRENTREQMTS, PCBO1.STOKSTAT.UNPLDISE, PCBOL1.STOKSTAT.STKCTDATE,
|=| DFS5AMD4 PCBO1.STOKSTAT.STOCKEY, PCBO1.STOXSTAT.AREA, PCBO1.STOKSTAT.ONORDER,
|=| DFssAMDS PCBO1.STOKSTAT.DIV, PCEO1.STOXSTAT.INSTOCK, PCBO1.STOKSTAT.PROJ, .
|=| DFssAMOS PCBO1.STOKSTAT.FLANDISE, PCBO1.FARTROOT.FART, PCBO1.PARTROOT.PARTDESC, SQL Bl_“lder
[2 pFssamo7 PCBO1.PARTROOT . PARTKEY c
_p I DFssAmos FROM PCBO1.STOKSTAT, PCB01.PARTROOT W|th Content
's:ng Multiselect. sql CRDER BY PCBO1.STOKSTAT.PRRTROOT PARTHEY ASC .
o paer.zd assistance to
sal parts.sqgl
o . - - g
sal Scriptl.sgl b d SQ
& seripta.sql UII a L
: ,5:";( S = STOKSTAT ELRTROOT
Script9.sgl
@i P lll |22 PARTROCT_PA~ | PART Statement
[<1 . | o /] UNPLREQMTS /| PARTDESC
[\ 7] UNIT 7| PARTKEY o
m Data Source Explorer T Navigamr} = . [ S | _»_’-J
=& G pmed T ~
=] EusADBzA[ \j [#ll|| ] oisTiveT V|eW W/
Columns | Conditions | Groups | Group Conditions |
Here you can | | Groups | Grow the SQL
Column Alias Qutput Sort Type Sort Order H
Cl'ea’[e SQL PCBO1.STOKSTAT.PARTROOT _PA... o Ascending 1 reSU|tS
A A PCBO1.5TOKSTAT, UNPLREQMTS v
SCI’Ip'[S Wlth PCBO1.STOKSTAT. UNIT v
PCBO1.5TOKSTAT.DEPT v —
SeleCt! Ldendies U P M EJ w| [l]
EeNCes 7 7
Update’ Lo Procedures = [ Properties [@ Error Log [& Problems [lj 50L Results &2 / b4 & |E|| ]
/
Delete, |nse n L PARTROOT_PARTKEY | UNPLREQMTS | UNIT | DEPT | UNITPRICE | CURRENTREQMTS | UMPLDISE H
statements ACKORDR. Status Operation Date Connecti. . [~/ 1 o210881293P009 200 o000 5% 0,000 1055 22 A
BAEESRa ] v Succeet Return All Rows 12/10/2011 ... IMSDB1 EA 0710651795°009 { 0000759 1.0:000 : .
ARTROOT ; e : i 3 02106B1293P00% i 58 | 0.182 320 0
v’ Succeec "PCBOL".PARTROOT 12/10f2011... IMSDB1 2 02250236001 200 o000 52 o000 210 S
£ STOKSTAT ¥ Succeec Return All Rows 12/10/2011 ... IMS DB1 5 02250235-001 0 0000 5% 0.000 o 10
(3 User-Defined Func v Succeet select * from pch0 1.STOKSTAT 12/10/2011... IMSDE1 6  02250236-001 ] 59 0.387 72 0
= U.ser-Deﬁned Type ¥ Succest SeriptS.sdl 12/10/2011... IMSDBE1 T 02250233 1] 59 0.550 58 ?
{3 Views L & started Multiselect.sql 12/10/2011 ... IMSDB1 g ggggggj g gggg gg g'ggg g ;g
0 Roles ¥ Succeec Multiselect.sql 12/10/2011 ... IMSDB1 :
& v 5l /10/2011 ... 10 02250794 i 58 0.174 320 0
- ¥ Succeec SELECT PCBOL.STOKSTAT.PARTR... 12/10/2011... IMSDB1 11 02250796 0 0000 59 0.000 1 2
=& fg*" ol oces [v] @ Faled SELECT PCBOL.STOKSTAT.PARTR... 12/10/2011... IMSDB1 12 02250796 0 59 1535 Pl 0 []
- il Pimbm Coms immm, __ P Sonennnd = sasae £ e A e A5
=1 e | 3] ¥ Succeec SELECT PCBO1.STOKSTAT.PARTR... 12/10/2011... IMSDB1 (€] m | (2]
: :¢ Database type: IMS_V11,Current profile: IMS DB1, Database: IMS DI21PART, connected | |
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Menu

EDIT
Command

F1=Help
Fl0=Left

Functions

Confirm

Utilities

IMSDATA. IM11A. JOBS

Name
ACBGEN1A
ARCHIVE
ASSEMBLE
AUDITSUP
AUDTPRT
BASKETDB
BASKETLD
BATSPOC
BATSPOC1
BMPDDLTO
BMPDDLT1
BSKLOADS
BSKRECON
BSKTIDX
BSTKPSB
CLSOLDS
COBCOMP

F2=Split

F11=Right

Prompt

F3=Exit
F1?=Cancel

Size
13
23
42
59

=
127
28
395
21
L3
37
248
54
20
38
25
ThH

F5=Rfind

Created
2007/11/26
2010/01/04
2009/04/21
2009/04/17
2006/11/23
2011/08/10
2011/08/18
2008701716
2009/12/01
2003/07/16
2009/07/07
2009!06525
2011/08/18
2011/08/10
2011708710
2007/08/20
2008/05/13

34" |Connected to remate server fhost winmys50. hursley.ibm. com using lufpool IYELTCOS and port 23

F7=Up

Row 00001 of 00091

Scroll

Changed

2011/08/718
2010/01/704
2009/07/28
2009/04720
2010/07/713
2011/08/710
2011/08/718
2010/02/719
2009712701
2009/07/06
2011/05726
2011/08718
2011/08/18
2011/08/710
2011/08/710
2011/05/718
2009/05/714

13:
17:
10:
11:
18:
18:
15:
13:
15:
18:
08
19:
14:
18:
18:
11:
12:

F8=Douwn

46 :
04:
31:
39:
42
59
(010
42
20:
01:
0o:
23:
18:
hq.
53:
25
144

===> PAGE

14
59
20
14
39
40
40
27
32
46
a1
35
15
40
40
a7

04/015

HP Photosmart E110 series on HP_192, 168.1.78_C
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.Y z/0S - IMSDATA.IM11A.JOBS(DFSERA10) - IMS Enterprise Suite Explorer

File Edit Mavigate Search Project Run  Window Help

Ci~ L R R e
U Data Sets &2 . Bs 2/0S UNIX Files g ¥ 7 0 || [B] MSDATAIM11A,J0BS{DFSERALD) 2 [E] DFSIVP3T | oFs1ve37 [ veoB2 " 1vPDB2.dbd
Qualifier: | IMSDATA.IM114,10BS (2 '

[E] AuprTsUP ]
|E1| AUDTPRT
|El| BASKETDE
Bl BASKETLD
|&1| BATSPOC
|B1| BATSPOC1
|E1| BMPODLTO
|E1| BMPODLT1
|E1| BSKLOADS
|B1| BSKRECON
[B1| BSKTIDX
|E1| BSTKPSE —_ .
& csoLs Browse data

B coBcomp ’

[E] peoGEM] sets
|E1| DBDGEM1A

|B1| DBRCASM

Ei| DBRCSTAT .
& oeror Edit a data

[E] orsBskTL set member
|E1| DFsBESKOD1

|El| DFSDDEF2

A, NOTIFY=CCUGHTZ,

PFRINT OFFSET=5, VALUE=LF, COND=M

MNew Data Set Member. ..

[E] DFSIVPL  Gpen "

& 10bs 22 8 Submit Job <f;; & ¥ = B || E Properties Bl console 2

JobName: | v+ | ¥ Delete Delete o0y | [E05
JOEID=JCEO5187 - submitted
- deleted

€. IM1ADLI - STCO5105 {IMSCREG) N
€ IM1AIRLM - STCO5100 (IMSCREG)
€. IM1ARM - STC05104 (IMSCREG)
€ IM1AOM1 - STCO5102 (IMSCREG)
@, IMIACONN - STCO5101 (IMSCREG) JES Output
& IM1ASCI - STCOS103 (IMSCREG) . .
& IMIACTRL - 5TCO5092 (IMSCREG) 1S dlsplayed
& IM1ACDEM - J0B05154 (COUGHTA) here

€ IM1AFP3 - JOBO5112 (IMSCREG)
€ IM1AFPZ - JOBO5111 (IMSCREG)
€ IM1AFP1 - JOBO5110 (IMSCREG) -
@ IM1AMPP - JOBO5109 (IMSCREG) [l

C ma

@ CMX0100I Connected user COUGHTA to host WINMYS50,HURSLEY . IBM.COM on port 21 : Fetching children of IM114,*

bn




IMS Explorer ... where do you get it from?

= Download as part of IMS Enterprise Suite
— ibm.com/ims
— - Click on IMS Enterprise Suite

!“Efl fm‘*ii‘“n

Download the IMS Explorer

-> Click on IMS Enterprise
Suite = Download o

Integrate
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= Stand-alone offering

= Shell-sharing offering for use with RDz 8.0.3 or Optim Development Studio 2.2.1.1 or
later

{MS Enterprise Suite

Downloads

To properly configure your download, please review the

appropriate offering. When you are done, press the "Cor
IM5 Enterprise Suite Explorer for Development
Offering
) ) |:| The installation repository file for M5 Explorer Stand-
@ i fqlifcrlltezr?r;se Suite Explorer for Development IMSExplorerz11.zip (700 MB) alone
Languages:
Englizh
|:| The installation repository file for the shell-sharing version of the IM5 Explorer
plug-in package to be installed on top of IBM Rational Developer for System z (8.0.3
() IMS Enterprise Suite Connect API or later) or IBM Qptim Development Studio (2.2.1 or later).
Version 2.1.0 IMSExplorer_S5211 zip (33MB) Shell-
Languages: Shaﬂng
Englizh

{:} IM S Enterprise Suite DLIModel Utility Plug-in
Verzion 2.1.0

Languages:
Englizh
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The IMS Explorer supports IMS Version 10 and later

your host system with Open Database implemented

Developer for System z Version 8.0 or later

— IBM Optim Development Studio Version 2.2.1.1 or later

— IBM Problem Determination Tools Plug-ins for Eclipse

To import COBOL and PL/I data structures, the IMS Explorer must be installed into Rational

For SQL access to an IMS database from IMS Explorer, you must have IMS Version 11 or later on

The IMS Explorer supports cross-product integration (shell-sharing) with the following products:
— Rational Developer for System z Version 8.0.3 or later

IMS Explorer for Development RDz shell-sharing environment non-RDz environment
Open Database IMS Catalog Open Database IMS Catalog
WITH WITHOUT WITH WITHOUT WITH WITHOUT WITH WITHOUT
Visualization/editing of PSB, DBD X
Access z/OS system - Files & Sysouts X (through RDz's native function)
Download & Upload PSB & DBD from X
z/OS
SQL access X X X X X X
Cobol and PLI import X X X X
Import source from Catalog (when X X X X
Catalog-enabled)
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Agenda

= IMS Explorer Overview

= DBD and PSB Graphical View
— Possible with IMS Explorer & without RDz

= IMS Explorer connecting to ODBM

= IMS Explorer using the IMS Catalog
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You import DBD and PSB SOURCE files and not MODULES !
— PCB must have a label

z/OS with IMS Explorer in stand alone
—You need a FTP server running on z/OS you want to pull PSBs and DBDs from.
— This FTP server has an IP address and a port it listens to.( some customers have more
than one FTP server, with different adresses than the z/OS.)
— You need a userid authorized to use that FTP server
—You need to pass any FIREWALL before trying a connection, host or client.

z/0OS with IMS Explorer in RDz
— You use the RSE function available with RDz ( daemon running in z/OS )

Local environment

— In that case, you need to upload your DBD and PSB source files to a local path
« IND$FILE, client FTP tool ..
» Don’t use copy/paste to create your DBD/PSB in local
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Connecting to z FTP server with Explorer version 2.1.1.0 ( DEC 2012) (1/2)

= Click Window>Preferences>Remote z/OS System connect>z/OS Credentials

Arbitrary name

Java Persistence
JavaScripk

JET Transformations
Model Yalidation

Modeling
Plug-in Development

Remote z/05 System Connections

o A L
LR = g =

Server

Team
Yalidation

Web

Web Services

XML W
@

AN
Authentication

User ID: ISABEL

Password;

[ ]5ave password

d save the

assword For this credential,

Saved passwords are stored on yaour computer in a file that is
difficult, buk naot impossible, For an intruder ko read,

-
\.;} Preferences /
z/05 Eredent/'éls
IMS Explorer [A]
InstalfUpdate Credential ./
Java v —
158
Java EE hame | / Q\ [VI

[ Restore Defaults ] [

Apply

]

ok ||

Cancel

|

PW is up to you

Your TSO userid.

/
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M

Connecting to z FTP server with Explorer version 2.1.1.0 ( DEC 2012) (2/2)

= Click Window>Preferences>Remote z/OS System Connections

Data Managemenk
Ecare Diagrarm
Help

IMS Explorer
Inskall/Update
Java
Jawa EE
Jawa Persistence
JawaScripk
JET Transformations
Model Yalidation
Madeling
Plug-in Developrient

+

(=)~ Remake 2/05 Syskem Conneckion,
205 Credentials
FuriDebug
Server
Tearn
Yalidation
Weh
Web Services
| KL vl

|

Qpreferences = @
Remote z/05 System Connections e
Y I
General [_/: [
ant Conneckion Mt

Tvpe: |S';.f5tem z-FTP

Connect

Location

Mame; | ZT01 blue

Hosk name: 9.212.143.123
Port numbet: | 21 ‘&
z/OS FTP server

Authentication
]

Credentials: | 154, -

FTP Additional Dekails

¥ | Click here I

©,

Transfer mode
E} Passive {:} Ackive

Atternpt secure conneckion

The credential nan
you have just crea

ne
ted

[ ]Enable MECS support

[ Restare Defaulks ] [ Apply ]

N

@

@) ) (e}
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Create an IMS Explorer Project

= Click FilesNew>Project>IMS Explorer Project from the main menu bar and give a nhame to your

project and click Next :

.Y New IMS Explorer Project @

Create a new IMS Explorer project

L

Enter a praject name.,

*Project name: | 1MSC Dealership applicatian

) New IMS Explorer Project

FX]

Select an Import Source

Import From:

| ¢ JE [ Mext = ] [ Finish ] [ Cancel ]

No FTP connection, DBD and PSB source

) Local file system <

Prerequisite: Before you can import IM3 resources, wou must copy the files From
walr 2/05 enviranment ko your local workstation by using FTP,

]
Hin
e
s
N
Hu
A

files available on local workstation

FTP connection available, DBD and PSB

Prerequisite: Before you can import IMS resources, wou must have access to a PDS
File in wour 205 syskem,

(11M3 cakalog <

source files available on z/OS partition

IMS 12 Catalog enabled

Prerequisite: Before you can import IMS resources from an IMS catalog-enabled
syskem, wou musk creake an IM3 conneckion prafile for that system,

What ?

@::l < Back “ Bexk = ] [ Einish ] [

Cancel
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Import PSBs from z/OS system

) New 1MS Explorer Project

Select Resources from

PSEs ko irpotk:

PSE (program specification block)

z/0S System

Connect to z/05 System and Select R

Browse the remake 205 syskem to seleck DEDs
and PSEs ko import from a PDS or Segquential

) Import IMS Resources (DBDs and P... - @
|
!

x%

System z connection: B g Mo 205 conneckion

High-lewvel qualifier:

DGy

PSE Mame

Path

a &

fdd 3B, ..

Start the connection
( pass the firewall before )

DED (daktabase description)
DBDs to impork:

DED Mame

@

Referencing P36 or DED

Path

fdd DELC. .,

Einish

|

H Cancel /]/

\ N\

O

Choose your PSB(s)

) Import IMS Resources (DBDs apwd P5SBs)

Connect to z/05 System and Select Reso |

Browse the remaoke 203 syskem ko seleck DBDs and fg ~|
P3EBs ko import From a PDS or Sgguential Data Set, ﬁ 2y

Systemn z connection: @ ~ ZT01 blue

High-lewvel gualifier; | IMs

[ Y11R1.5DFSEXEC

=0 ¥11R1.5DFSISRC

ARCHICL

CAICL

o5

[B| csLbcoon v

v

®

- T3

on



- ~1
. New IMS Explorer Project LY New IMS e @
Select Resources from z,/05 System

J Impaort IMS Resources (DBDs and PS

Select Resources from z,/0S System
Connect to z/05 System and Select

Browse the remote /09 swstem to select DBDs

PSE (program specification block) =
P3E (program specification block)

PSBs ko impart: .
PSEs toimport:

System z connection; @+ ZT01 blue

High-level qualifier: | IMSCFG.IMSC PAR AUTPEBL1 IMSCFC.IMSC. PSB. ALUTPSBLL
Delete PSE

e e h
ALTPSBLL IMSCFG.IMSC.PSE. ATPSELL EaB.blale Eat I

|E1| AUTOPSEL
|E1| AUTOPSE

< B
1) CELPSEL
lEI CELPSBL DED {database description) e
E] s op DED {database description)
|E| CELPSBLG DEDs= ta impart:
|E1f CELPSEZ DED Mame Referencing PSE or DED Fath E
B cheny DED Mame Referencing PSE ar DED Path add DED. ..
El EMPLDEL ALUTPSELL IMSCRG, IMSC,L
|1l CMPHYG SINDEXZZ AUTPSELL IMSCFG,IMSC.| Delete DED
DEALERL AUTPSELL IMSCFG IMSC.L
< . , .
/& DBDs bo impaort For the selected PSBs or DEDs:
/& DBDs toimport for the selected PSEs or DEDs:
,/aa. This lisk shows any DBEDs that you skill need to import based on)
'\U' selected PSEs or DBDs, because a PSE or a DBD that wou adde]|  This lisk shows any DEDs that you still need to import based on your
references that DED. celected PSBs or DEDs, because a PSE or a DBED that vou added
TETET B ILes tia 3
DBED Marne Referencing PSE aor DED
EMPLDEL ALUTPSBLL DBD Mame Referencing PSE or DED
DEALERL ALTPSELL EMPLDE DEALERL,EMPLOEL
It tel Is_ yo_ u SINDEX22 AUTPSELL DEALERDE DEALERL,EMPLOEL,SINDER®22
the missing
DBD names!

i
-
(?) Finish ] [ Cancel




» Double-click on the DBD you want to see

) IMS Explorer - I4S Explorer ZT01 Project/DBD/AUTODB. dbd - IMS Enterprise Suite Explorer =<
File Edit Mavigate Search Project FRun  Window Help

e i Q- i A el i %% Debug [(Ymse 7
W8 pata [T Navig 22 = O B prswe1 & vrDB1.dbd &’ 1vPDB1L.dbd " vPDB3,dbd & 1vrDB4.dbd i auToDB.dbd E2 . TR = [m]
= <=~ |||l Project: IM3 Explorer ZT01 Project || Database mame: AUTODE || Database access type: (HISAM,¥aaM) ||
= l‘j, IM3 Explorer ZTOL Project | Vi <
=i oeD -
id
0" Al DBD name: AUTODB
' CELDCUST.dbd
G'? CELDC LIS, dhd — CUSTOMER

F CELDPROD.dbd
F CELDPROY.dbd =

F cMPoE2.dbd e CUST'iEY
F cMPoE2Y.dbd I
¥ DEALERDE.dbd [ |

6" DEALERL.dbd — ADDRESS = POLICY

' DIZ1PART.dbd Length: 100 bytes Length: 250 bytes

" DI1EHA.dbd — -
¥ DIZEHA.dbd N CLERLEE B POLICTM

" D13ED.dbd |
6’ po3era.dbd [ |

Length: 75 bytes

" DI3rD.dbd
" DI3FHA.dbd
" EMPLDE.dbd

— CLAIMS
Length: 250 bytes

— PREMIUMS
Length: 30 bytes

FoL CLATMMM

L RISKLIMI

¥ EMPLDEL.dbd
¥ ETOSDE.dbd
F FPiE.dbd
& FriF.dbd
¥ FPzE.dbd [’ AUTODB
F FraF.dbd
" FP3E.dbd
F FP3F.dbd Property valus
G GPRTICL.dbd
" 18CLOME.PDEZ.dbd [

£ >

i . Fetching children a...R.1.SDFSISRC

r F

B Properties £2 & Error Log | [21 Problems o &3 Hinm
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Agenda

= IMS Explorer Overview
= DBD and PSB Graphical View
= IMS Explorer connecting to ODBM

= IMS Explorer using the IMS Catalog
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Access IMS Data using JDBC and IMS Open Database

= Distributed Relational Database Architecture (DRDA)
— Set of protocols and functions for client and database servers connectivity
— Communication protocol

— Two-Phase commit protocol

— Security

SQL code

or
result set

H

SQL

Winidows

~

\_

.

~

I~

IMS
Universal
Database

Driver

Y

~

g <

Distributed Data Management : DRDA protocol

IMS Connect is the server for DRDA messages sent via the TCP/IP protocol

-

A

\J

TCPIP

! ' z/OS '

~

~/
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Using the Data Store Explorer

= Using the Explorer to generate SQL statements for use with IMS Open DB

= First add the definition for the Universal JDBC Driver: Click Window > Preferences >
Data Management > Connectivity > Driver Definitions> Add

r T & |
'\J' Preferences . @
type filter text Driver Definitions Bt
®- General T [P
] e I -
- Ant Filter: | All bl
= Data Ma!@gemn.ant : Mame System Vendor System Yersion
o e | 5/400 Toolbox for Java Default DB for i5/05 VER3
= Connectivity Cloudscape - Cloudscape Embedded ...
Driver Definitions Cloudscape - Other Driver Default
Cpen Data Access | S Derby 10.0 - Embedded JDBC Driver ... Derby 10.0
Data Object Compare Derby 10.0 - IBM Data Server Driver ... Derby 10,0
DE2 Optians Derby 10.0 - IBM Date! Server Driver ... Derby 10.0
- Diagram Derby 10.0 - Other Driver Default Derby 10.0
- Cerby 10.1 - Derby Client JDBC Drive... Derby 10.1
e Derby 10,1 - Embedded JDBC Driver ... Derby 10.1
+- Mapping Editor —!|" | Derby 10.1 - IBM Data Server Driver ... Derby 10.1
- SQL Development Derby 10.1 - IBM Data Server Driver ... Derby 10.1
[#- Ecore Diagram Derby 10.1 - Other Driver Default Derby 10.1
- Help Cerby 10.2 - Derby Client JDBC Drive.., Derby 10.2
& InstalUpdate Derby 10,2 - Embeddgd IDBC Driver ... Derby 10.2
= Java Derby 10.2 - Other Driver Default Derby 10.2
=+: ] Scriot Generic JDBC 1.0 - Generic IDBC Driv... Generic JDBC 1.0
B _ IBM Data Server Driver for JDBC and ... DB2 for /05 ¥2, 1 (New-Fun... =
- JET Transformations TRM Nata Server Driver fir MRC and MR2 for Linow TIMTY  and Windowe Wa 1 B _-.v.'
IPA ™ EA I L
@ ok || cancel
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Using the Data Store Explorer...

Qv

Genersl
Ant
CICS Explorer
=)~ Data Management
Administrative Options
(=) Connectivity

Cimb =l fal +

Driver Definitions

S e

Data Object Compare

DB2 Options

DDL Generation
Diagram
Key Migration

Label Decorations

SGL Development
Ecore Diagram

Help

-TM5 Explarer

- InstallUpdate

Java

Java EE

Java Persistence
JavaScript

JET Transformations
Model validation
Modeling

Plug-in Development
Remote Systems
Run/Debug

Server

Team

Validation

'\."'."Eb

Web Services

ML

L B R e B R e B e e =

E-E-E

Profile

Driver Definitions

[ %l

S

Filter: | Al i = 05
Name System Vendor System Version || Add... — An d
AS/400 Toolbox for Java Default DB2 far i5/05 YER.3 -
Cloudscape - Cloudscape Embedded ... Edit
Cloudscape - Other Driver Default m—
Derby 10.0 - Embedded J0BC Drive] .Y New Driver Definition %

Derby 10,0 - IBM Data Server Drive
Derby 10.0 - IBM Data Server Drive
Derby 10,0 - Other Driver Default
Derby 10,1 - Derby Client JDBC Dri
Derby 10.1 - Embedded JOBC Drive|
Derby 10,1 - IBM Data Server Drive
Derby 10,1 - IBM Data Server Drive
Derby 10.1 - Other Driver Default
Derby 10,2 - Derby Client JDBC Dri
Derby 10,2 - Embedded JDBC Drivel
Derby 10.2 - Other Driver Default
Generic IDBC 1.0 - Generic JOBC D
HSQLDE 1.8 - HSQLDE JDBEC Driver
IBM Data Server Driver for JDBC an
IBM Data Server Driver for JDBC an
IBM Data Server Driver for JDBC an
IBM Data Server Driver for JDBEC an
IBM Data Server Driver for JDBC an
IBM Data Server Driver for JDBC an
IBM Data Server Driver for JDBEC an
IBM Data Server Driver for JDBC an
IBM Data Server Driver for JDBC an
IBM Data Server Driver for JDBEC an
IBM Data Server Driver for JDBC an
IBM Data Server Driver for JDBC an
IBM Data Server Driver for JDBC an
IBM Data Server Driver for JDBC an
IBM Data Server Driver for JDBC an
IBM Data Server Driver for JDBEC an
IBM Data Server Driver for JDBC an
IBM Data Server Driver for JDBC an
IBM Data Server Driver for JDBEC an
IMS Universal JDBC Driver Default
TS )

C T B P [ =Tl

Specify a Driver Template and Definition Hame

Specify a driver template, then modify details in the fields below to provide a unique name, a list of
required jars, and set any available and applicable property values.

Name/Type | JaR List | Properties |

Vendor Filter: |.-!\II

Available driver templates:

Mame

System Vendar

System Version

IBM Data Server Driver for JDBC DB2 for z/05 ¥9, 1 (Mew-Func...
IBM Data Server Driver for IDBC DE2 for i5/05 WER3
IBM Data Server Driver for JDBC DB2 for Linux, UMIX, and Windows ¥g.1 =
Ioea - ol Ea Fe (=l e i AL Ca i Nt =
TE BBt EErr—far—es o
! IMS Universal JDEC Driver M5 Vii
Informiy IDRC Driver Informi 10,0
Informix JDBC Driver Informix I
Infarmix JDBC Driver Informix 11.1
Informix JDBC Driver Informix 11.5 [v]
Drriver name:
IMS Universal JDBC Driver
Driver type:
IMS Universal JDBC Driver
@ oK. Cancel
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= Right click “Database Connections”, in the DSE window, then “New”. Complete the
Connection Parameters.

\.} \) New Connection @

Connection Parameters

i % G 4 Select the database manager, JDBC driver, and required connection parameters,
e BN | Right click
— <}c::'; ﬁ’ =3 annection identification
== Database Com&ﬁﬁs/ [w]Use default naming conventian

E4 BIRT Classic Models Sam
E4 Derby Sample Connectio
= @ IMS DB £T01 IMEL

Connection Name:

Select a database manager:

=[] ™MsDB ;
= Catalogs SIE'DZUIC’I;E?EI%S IDEC driver: |IMS Universal JDBC Driver v A
= | DFsIvPaz

DEZ For Linu, UMIX, and Windows
=1l Schemas DEZ Far 2/05

= Q@ FHO Derbry Properties
Gaeneric JDBC
+ D ; HSOLDE *Connection narme: | IMS DB .A
o\
~ EMcS ; l Diaka store:
-] 9 inin=i:
i~ MaxDE T
= 1 Host:
T I mysaL s 9.212.143.123
el orade *Part numbier: 9975
-] U SQL Server
w71 |Svbase User name: ISABEL
= ‘websphere
ek Password: P T L]
4 Roles
#-[71 Users Save password
] 13 0B Hursley Makadat
= @ 15 DB ZT01 IMC1 The IMS Universal JDBC driver uses this information to process SQL calls bo M3, Select a PSE or specify a Java metadata class
T D M5 DE 2T01 {generated by the DLIModel utility phug-in or IMS Explorer),
=-[= CD# Data Sources o IM5 Catalog
(= Classic Madels Inc. Samp 4| P3E:
[= Flat File Data Source
(= IDEC Data Source Toral IS ExpIorer project .
= Web Services Data Sour ® Project: | ZT01 IMB1 IMS Explorer hd
[=F ¥ML Data Source = CFSIVPT] -

J b
Test Connection :

ks

= Database Cornect| =" Mext = ] [ Finish l [ Cancel

T T T T — v oo s



Using the Data Store Explorer...

= Optionally set SSL on for the connection, and/or specify a log-in timeout value.

| \.} MNew Connection

|| Connection Parameters

Select the database manager, JOBC driver, and required connection parameters.

Cannection identification
Use default naming convention

Connection Mame:

Select a database manager:

Cloudscape
DBZ for i5/05
DEZ Far Linus, UMIX, and Windows
DBEZ for )05
Derbey
(eneric JDEC
HSOLDE

IM5

Infarmis
MaxDEB
MySQL
Cradle

SOL Server
Svbase
‘Websphere

Test Conneckion

IDEC driver: | IMS Universal JDBC Driver

Properties
Gereral | Tracing | Optional i

Use 551 fFor connection: |N0

e

| %
|

Log-in timeout value:
Additional Connection Properties

Property name: Property valug:

fetchsize=0;

Marve Up
Clear Al

Seconds

Mext = ] [

Finish l [ Cancel

@
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= Success! Results are returned:

|~J IMS Explorer - ZTO1 IMB1 IMS Explorer/DBD/IYPDB2.dbd - IMS Enterprise Suite ExploN'

File Edit Mavigate Search Project Run  Window Help

g Q- A S

Data Source Explorer &3 T3 Mavigator == =] IWPDEZ =] IVPDBZ @ DFSI¥F37 .psb IYPDEZ.dbd # vPoB2.dbd 52
= d:o ﬁ’ 15 || =@ I?\él Iﬁl E = |||l Project: ZTOL IMEL IMS Explorer ||  Database name: IWRDEZ || Database access bype: (HDAM,WSAM) ||

=I-[= Database Connections
4 BIRT Classic Models Sample Database

&4 Derby Sample Connection DBD name: IVPDB2
= g] IMS DE ZT01 IME1
=0 mspe = Al1111111
=0 C_atalogs Length: 40 bytes
= U DFsmveE Fla1111111
=[] Schemas —

[rak
=-B% PHOMEAP =
+-(_J Dependencies # Drop

+-[) Sequences
[ Stared Procedures | 24 Add ko Overview Diagram

=3 Tabl
e e 2 Generate DOL...
+ o Alll1111

= User-Defined Funct| 542 analyze Impact. ..
+-[] User-Defined Types
Compare With

) iews

* '_' i m Create EJBs from Tables (1.x-2.x)
+-_ Users
) S DB Hursley =] Copy
=-4ll) IM5 DB ZT01 IMC1 Refresh
=-[J ms DB zT01 v’ Succeeded Return AllR...
=/-[= OD#A Data Jources v Succeeded Return AllR...

(= Classic Models Inc. Sample Database
(== Flat File Data Saurce

[ IDBC Data Source

= Web Services Data Source

(= ML Data Source

v E Return all Rows
Edit
Load...
Extract...

) Sample Contents

El sqQL Results 52

Skatus | Rdsultl

Connection Profile A11T4111
LUDS309000
LUO1505000
LASTE
LUOZ141000
LUOE363000
LUOG356000
LUOZ356000
Lu00z13000
9 LUOS158000
10 LU01574000
11 LUOS102000
12 LU0Z2Z30000
13 LU02172000

F=

27 féwr, 2012 16:07:21 IM3 DB ZT01 IMEL
27 Féwr, 2012 16:11:15 M5 DB ZT01 IMB1L

00w O A b L R e

| > | Tatal 139 records shown

»

Y L3 Database De... 3

=0

WiEw @
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Agenda

= IMS Explorer Overview
= DBD and PSB Graphical View
= IMS Explorer connecting to ODBM

= IMS Explorer using the IMS Catalog

© 2012 IBM Corporation



Types of technical metadata and storage medium

= DB

— PSB/DBD resources
*Database structure definitions
*Physical database definitions
*Segment definitions
*Field definitions

— Application
«Data types
*Application defined fields
*Encodings
*Redefines
*User defined types
«Structures

= T™M
— MODBLKS resources
*Program definitions
*Transaction definitions
— FORMAT resources
— Application
Input/output message definitions

Catalog

Repository
Primary

IMS database

VSAM data sets

Repository
Secondary

Repository
Spare
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Before the IMS Catalog

» Databases partially defined in DBD
— Only searchable fields needed by applications
— Remaining segment data is not defined

» Remaining database definition in applications
— COBOL copybook maps segment data
— Applications can have different segment mappings

PSBLIB ACBLIB DBDLIB

PSB source DBD source

COBOL/PLI
source

DL/I model utility
Java classes
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IMS Catalog life cycle

COBOL/PLI
source
PSB++ PSBGEN
| — source PSBLIB++
|
|
I DBD++ source DBDGEN
- DBDLIB++

DB Client Route

«  Utility will populate catalog

« ACBGEN will populate ACBLIB and catalog
« Populate ACBLIB with standard ACB info and extended info
» Populate catalog with extended info

« Key points
* Only way to update catalog is via the ACBGEN process
» Extended info stored in ACBLIB members for recoverability
« Extended info is acquired via the IMS Explorer
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Catalog runtime access

LSS DRDA/TCPIP SQL/DLI

Drivers
(SQL/DLI/XML)

SQL/DLI

Catalog

DB DB

ODBM

DRDA DL

SQL/DLI
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Agenda

= IMS Explorer Overview
= DBD and PSB Graphical View
= IMS Explorer connecting to ODBM

= IMS Explorer using the IMS Catalog
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